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Approvals:   

Preparer: Hetal Doshi                                                    Date: 10JAN24 
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1.0 Harvest, Centrifugation, and Concentration  
1.1 Description 

This batch record directs and documents the isolation of nist mAB from conditioned 

medium of producer CHO cells grown in a bioreactor, providing bench scale 

Downstream Processing procedures to : 

 1).  Clarify conditioned medium by centrifugation to remove cells and debris 

 2).  Concentrate cNIST mAB in conditioned growth medium by tangential flow filtration 

      The method demonstrates the principles of Centrifugation and Tangential Flow 

Filtration. 

 

 

     1.2 References 

Title Doc # 

SOP: End-of-Run cNIST mAB Process: Harvest, Centrifugation, TFF 

concentration  

DP  

URL for Labscale User Guide and Documentation: 

http://www.emdmillipore.com/Web-US-Site/en_CA/-

/USD/ViewParametricSearch-

SimpleOfferSearch?SearchTerm=+labscale++pellicon&SelectedSearchResult=SFD

ocumentSearch&SearchContextPageletUUID= 

N/A 

  

     1.3 Equipment 

Equipment Type Manufacturer, Model ID # Initials/Date Verifier/Date 

Tangential Flow 

Filtration System  

Millipore Labscale 500ML      

Ultrafiltration 

Cassette 

Millipore Pellicon XL 

PXC030C50  

   

Centrifuge Dupont Sorvall RC5    

Centrifuge Rotor Sorvall SLA 1500    

Centrifuge Rotor Sorvall SS-34    

 

 

 

 

1.4. Materials 

http://www.emdmillipore.com/Web-US-Site/en_CA/-/USD/ViewParametricSearch-SimpleOfferSearch?SearchTerm=%2Blabscale+%2Bpellicon&SelectedSearchResult=SFDocumentSearch&SearchContextPageletUUID=
http://www.emdmillipore.com/Web-US-Site/en_CA/-/USD/ViewParametricSearch-SimpleOfferSearch?SearchTerm=%2Blabscale+%2Bpellicon&SelectedSearchResult=SFDocumentSearch&SearchContextPageletUUID=
http://www.emdmillipore.com/Web-US-Site/en_CA/-/USD/ViewParametricSearch-SimpleOfferSearch?SearchTerm=%2Blabscale+%2Bpellicon&SelectedSearchResult=SFDocumentSearch&SearchContextPageletUUID=
http://www.emdmillipore.com/Web-US-Site/en_CA/-/USD/ViewParametricSearch-SimpleOfferSearch?SearchTerm=%2Blabscale+%2Bpellicon&SelectedSearchResult=SFDocumentSearch&SearchContextPageletUUID=
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Component 
Quantity 

Required 

Quantity 

Used 
Initials/Date 

Verifier/ 

Date 

250 ml Nalgene centrifuge bottles 3-4    

Bottle-top vacuum 0.22 µm filtration 

device 
1 

   

250 ml Corning bottles 3-4    

10ml graduated cylinder  1    

25 ml beaker 1    

50 ml beaker 1    

Nalgene Oak Ridge centrifuge tubes 2-4    

     

     

1.5. Reagents     

Reagent Name 
Vendor 

Name 

Catalog # Initials/Date Verifier/ 

Date 

Sodium Hydroxide (NaOH)     

Tween 80     

1X PBS     

MilliQ Water     

Halt cocktail protease inhibitor solution 

(100X) 
    

     

      

  1.6 Procedure: 

          1.6.1. Preparation of Solutions 

 
 Solution Initials/Date Verifier/ 

Date 

Step     0.1N NaOH for cleaning   

1 Weigh 3.2 g ± 0.05g NaOH   

2 Transfer the solid NaOH to a 1000 ml beaker with stir bar.   

3 
Measure 700ml of milliQ water with a 1000ml measuring 

cylinder and add to the beaker containing NaOH 

  

4 
Add magnetic stir bar and stir the solution to dissolve the 

NaOH solids by placing the beaker on the stirrer plate 

  

5 
When the NaOH is completely dissolved, bring the 

solution to its final volume of 700ml with milliQ water 

  

6 
Sterile filtered the solution with 0.2 micron vacuum filter. 

Label the bottle: 0.1N NaOH, Date, Initials, Team Name 

  

7 Store the bottle at Room Temperature   
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      0.05N NaOH for Pelicon XL cassette storage Initials/Date Verifier/ 

Date 

1 
Pipet 5 ml MilliQ water into a 15 ml plastic conical tube 

with screw cap. 

  

2 
Pipet 5 ml 0.1N NaOH into the same tube, cap, mix and 

label appropriately. 

  

3 

Sterile filter the prepared solution with 0.2-micron syringe 

filter attached to a 10ml syringe in a sterile 15ml conical 

tube. Label the tube appropriately 

  

 
     10% w/v Tween 80 Initials/Date Verifier/ 

Date 

1 

Measure 80 ml MilliQ water using a 100ml measuring 

cylinder and transfer to a 200ml clean beaker. Add a 

magnetic stir bar into a 200 ml beaker. 

  

2 
Place the beaker on a balance and tare the balance when 

stable. 

  

3 
Pour 10 g Tween 80 solution (polyoxyethylene sorbitan 

monooleate) into the beaker with water. 

  

4 

Stir until all of the Tween 80 is dissolved; this can take 30 

minutes or more to complete. Carefully adjust the stir plate 

rpm to provide adequate mixing vigor without introducing 

air bubbles or frothing. 

  

5 

Transfer the solution to a 100 ml graduated cylinder, rinsing 

the beaker walls with a small amount of  MilliQ water 

(which is then added to the cylinder). 

  

6 Adjust the final volume to 100 ml.   

7 
Sterile filter the prepared solution with 0.2 micron vacuum 

filter ssytem 

  

8 
Store the solution in an appropriately labeled bottle at room 

temperature. 

  

 
1X PBS with 0.1% Tween 80 Initials/Date Verifier/

Date 

1 
Measure 79.2 ml of 1X PBS with 100 ml graduated 

cylinder 

  

2 
Transfer the 79.2ml of measured 1X PBS into a clean 

beaker 

  

3 
Measure 0.8ml of 10% v/v Tween 80 with a serological 

pipete and add to the 1X PBS 

  

4 
Stir until all of the Tween 80 is dissolved with a magnetic 

stirrer and stirrer plate 

  

5 
Transfer the prepared 1X PBS with 0.1% tween 80 into 

clean labelled bottle 
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6 Store the solution at room temperature   

 
Sterile filtered MilliQ water Initials/Date Verifier/

Date 

1 

Measure 1000ml milliQ water and sterile filter the water 

using a 0.2-micron vacuum filter and labelled the bottle as 

sterile filtered milliQ water, date and initials 

  

 

 

 

 1.6.2. Preparation of the Labscale TFF System    

 

 Note: Become familiar with the location of ports and tubing connection 

points as shown in the following diagram prior to beginning setup. Also 

refer to attachment Figures 1-3, found at the end of this document, for 

correct configuration of the tubing and cassette connections to ports. 

 

 

  

# Task 
Initials/ 

Date 

Verifier/ 

Date 

1 

If necessary, set up the apparatus and confirm that all tubing 

connections are secure, according to the SOP (Millipore 

Tangential Flow and Diafiltration Using Pellicon XL Device of  

SOP). 

  

 

2 

Remove the 4 plugs on the Pellicon XL ( PXC030C50) cassette 

ports. Align the Pellicon XL device ports with Labscale 500 ml 

Reservoir ports being sure the PERM and RET DEVICE ports of 

  

http://www.millipore.com/
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the Pellicon XL Device and reservoir match. Press the device 

firmly onto the reservoir ports. Turn the lock nuts until snug.  

     

1.6.3. Flushing the Pellicon cassette. 

# Task 
Initials/ 

Date 

Verifier/ 

Date 

1 
Disconnect retentate silicone (translucent) tubing from RET IN 

port and place end of retentate tubing in waste collection vessel. 

  

2 

Place end of permeate silicone (translucent) tubing into waste 

collection vessel.  Open retentate valve by turning it 

counterclockwise.  

  

3 

Remove the reservoir cover and fill reservoir with 500 ml of 

MilliQ water. Remove the plug from VENT port and open tank 

outlet valve.  

  

4 
Turn the pump on and increase the speed until the feed pressure 

gauge reads 20 psi. 

  

5 
Continue pumping to the waste collection vessel until the level 

in the reservoir drops to 350 ml and then turn the pump off.  

  

6 

Reconnect the retentate silicone (translucent) tubing to the RET 

IN port and turn the pump on. Slowly increase the pump speed 

until the feed pressure gauge reads 20 psi. Check the system for 

leaks and tighten connections if leaks are found.  

  

7 

Adjust the retentate valve restriction by slowly turning the 

retentate valve clockwise until the retentate pressure gauge reads 

10 psi. 

  

8 
Adjust pump speed and retentate valve restriction to achieve 30 

psi feed pressure and 10 psi retentate pressure.  

  

9 
 Allow to run until 50 ml remains in the chamber, then stop the 

pump. 

  

10 
Disconnect the pump outlet (Sta-pure, white) tubing from the 

pump outlet port and place in waste collection vessel.  

  

11 

Disconnect the retentate silicone (translucent) tubing from the 

RET IN port. Open the retentate backpressure valve by turning 

counterclockwise. Fluid will now drain by gravity. If additional 

drainage is required, a syringe can be placed on the end of the 

retentate tube and fluid can be blown down.  

  

12 

Remove the remainder of water in the chamber as follows: 

Replace retentate tubing (silicone, translucent) in retentate port. 

Reconnect pump outlet tubing (Sta-Pure, white).  

  

13 
Disconnect FEED IN tubing and place in collection vessel. Open 

tank outlet valve, turn pump speed up to drain reservoir.  
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14 
Reconnect the pump outlet tubing (Sta-Pure, white) to the Feed 

In port. 

  

 

 

         1.6.4.  Pre-conditioning the Pellicon cassette 

# Task 
Initials/ 

Date 

Verifier/ 

Date 

1 
Place end of permeate tubing silicone (translucent) in the waste 

collection vessel. 

9.1.2.4  9.1.2.5  
 

2 

Remove reservoir cover and fill the reservoir with 50 ml of PBS 

containing 0.1% Tween 80 (or other appropriate buffer) and then 

remove the Vent port plug.  

  

3 

Open the tank outlet valve. Turn the pump on and increase the 

pump speed until the feed pressure gauge reads 20 psi at its 

maximum; the needle will pulse as the pump turns. Check all 

system connections for leaks and tighten any connections as 

necessary.  

  

4 

Continue pumping to the waste collection vessel until the level 

in the reservoir drops to the bottom of the reservoir stir bar well 

making sure to stop the pump before air is pumped into the 

system. Turn the pump off. Close the pump outlet valve. 

  

    

     

       1.6.5. Clarification of culture medium by centrifugation & filtration. 

# Task 
Initials/ 

Date 

Verifier/ 

Date 

1 

Refer to the SOP: Applikon ez-Control Bioreactor Controller 

Operation for instructions on removing the headplate of the 

bioreactor, providing access to the cells and conditioned 

medium.  

  

2 

Transfer the culture to three 250 ml centrifuge bottles using a 

100ml pipet and PipetAid.  Residual culture can be transferred to 

a clean sterile bottle for temporary storage. 

  

3 

Centrifuge cells in pre-chilled Sorvall centrifuge, fitted with a 

SLA1500 rotor,  at 2500x g for 10 min, 4 degrees C.Repeat with 

the rest of the culture medium 

  

4 

To further clarify the conditioned medium, carefully decant the 

supernatant into/through a bottle top 0.22µm vacuum filter 

mounted. Apply the vacuum and complete filtration of the 

medium.  

  

5 Add protease inhibitors and Tween 80 as follows:   
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 To each 250 ml of Conditioned medium, add 250µl of 100X 

halt protease inhibitor cocktail stock to achieve 1X final 

concentration. Also add 2.5 ml 10% Tween 80 (final 

concentration will be near 0.1%).  

 

         1.6.6.Concentration of Anti-Il8 mAb in conditioned medium 

 Task 
Initials/ 

Date 

Verifier/ 

Date 

1 Make sure the TFF system is flushed and preconditioned   

2 
Remove the reservoir cover and fill the reservoir with cNIST 

mAB sample (up to 500 ml) to be concentrated.  

  

3 Ensure the 0.2µm syringe filter is attached to the VENT port.      

4 Open the tank outlet valve   

5 

Turn the pump on and increase the pump speed until the feed 

pressure gauge reads 20 psi. Check all system connections for 

leaks and tighten any connections as necessary.  

1.1.1.1. 1.1.1.2. 

6 

Adjust the retentate valve restriction (black knob on top) by 

slowly turning the retentate valve clockwise until the retentate 

pressure gauge reads 10 psi. 

1.1.1.3. 1.1.1.4. 

7 

Adjust the pump speed and retentate valve restriction to achieve 

desired feed and retentate pressures: 30 psi feed / 10 psi 

retentate. Do not exceed 60 psi feed pressure.  

1.1.1.5. 1.1.1.6. 

8 
Concentrate the solution until approximately 40ml of retentate is 

left 

1.1.1.7. 1.1.1.8. 

9 

Turn off the pump and empty the permeate container into a large 

bottle with a cap and label as: cNIST Mab, Permeate Waste, 

disposal; bleach then drain, [initials], [date].  

1.1.1.9. 1.1.1.10.  

10 

Measure the volume of the retentate in the reservoir with the 50 

ml serological pipette 

Volume of the retentate in reservoir: _______________ml 

1.1.1.11.  1.1.1.12.  

     

 

1.6.7. Recover the concentrated conditioned media  

# Task 
Initials/ 

Date 

Verifier/ 

Date 

1 

Disconnect the pump outlet tubing (Sta-Pure, white) from pump 

outlet port and place in product recovery collection vessel 

(beaker or cleaned sterile 50 ml conical tube).  

  

2 

Disconnect the retentate tubing (silicone, translucent) from the 

retentate in port and open the retentate back pressure valve (turn 

counterclockwise). Fluid should now drain by gravity into the 50 

ml conical tube 
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3 

When drainage ceases, rinse the Pellicon innards by injecting 5 

ml of 1X PBS with 0.1% Tween 80 from the retentate tube using 

a 10 ml syringe. To expel any remaining liquid, use a syringe 

attached to the end of the retentate tube to force fluid down/out 

with air. 

1.1.1.1. 1.1.1.2. 

4 
Replace retentate tubing (silicone, translucent) in retentate port. 

Reconnect pump outlet tubing (Sta-Pure, white). 

1.1.1.3. 1.1.1.4. 

5 
Disconnect FEED IN tubing and place in collection vessel. Open 

tank outlet valve, turn pump speed up and let the reservoir drain. 

1.1.1.5.  

6 
Turn pump dial to stop the pump. Reconnect the pump outlet 

tubing (Sta-Pure, white) to the Feed In port. 

1.1.1.6.  

7 Close the tank outlet valve 1.1.1.7.  

8 
Add 10 ml of 1X PBS with 0.1% Tween 80 to the reservoir. 

Open the tank outlet valve 

1.1.1.8.  

9 

Connect the male luer end of the permeate tubing to the 

recirculation (DIA / RECIRC) port. Turn the pump on and 

increase the pump speed until the feed pressure gauge reads 20 

psi. Check all system connections for leaks and tighten any 

connections as necessary. 

1.1.1.9. 1.1.1.10.  

10 

Adjust the retentate valve restriction by slowly turning the 

retentate valve clockwise until the retentate pressure gauge 

reads10 psi. Adjust the pump speed and retentate valve 

restriction to achieve 30 psi feed pressure and 10 psi retentate 

pressure. 

1.1.1.11.  1.1.1.12.  

11 
Recirculate the 1X PBS with 0.1% Tween80 for 10 minutes and 

then turn the pump off. 

1.1.1.13.  1.1.1.14.  

12 

Disconnect the pump outlet tubing (Sta-Pure, white) from pump 

outlet port and place in cleaned sterile 50 ml conical tube used in 

step 1 of 1.6.7. Disconnect the male luer end of the permeate 

tubing from recirculation port and place it in waste collection 

vessel. 

1.1.1.15.  1.1.1.16.  

13 

Disconnect the retentate tubing (silicone, translucent) from the 

retentate in port and open the retentate back pressure valve (turn 

counterclockwise). Fluid should now drain by gravity. 

1.1.1.17.  1.1.1.18.  

14 

When drainage ceases, to expel any remaining liquid, use a 

syringe attached to the end of the retentate tube to force fluid 

down/out with air 

1.1.1.19.  1.1.1.20.  

15 
Replace retentate tubing (silicone, translucent) in retentate port. 

Reconnect pump outlet tubing (Sta-Pure, white). 

1.1.1.21.  1.1.1.22.  

16 
Disconnect FEED IN tubing and place in collection vessel. Open 

tank outlet valve, turn pump speed up and let the reservoir drain. 

1.1.1.23.  1.1.1.24.  



Montgomery County Community College    Document Number: NDP 06 

340 DeKalb Pike       Revision Number: 0 

Blue Bell, PA 19422                  Effective Date: 17JAN24 

         Page 9 of 27 

Batch Record for Downstream Processing of cNIST mAb 

Lot Number: _______________ 
 

17 
Stop the pump, close the outlet valve and reconnect the pump 

outlet tubing (Sta-Pure, white) to the Feed In port 

1.1.1.25.  1.1.1.26.  

18 

Label the recovery collection vessel as Concentrated cNIST 

mAb, [date], [initials], company name. Measure and record the 

volume. 

Volume of concentrated cNIST mAb: ____________ml 

1.1.1.27.  1.1.1.28.  

19 
Store for the short term (1 week) in 2°C-8°C refrigerator for use 

in further purification steps.  

1.1.1.29.  1.1.1.30.  

     

     

 1.6.8. Cleaning the Pellicon XL cassette ultrafiltration membrane.    

 

Cleaning of the Pellicon cassette and its internal ultrafiltration membrane 

is achieved by: 

 1. flushing the system with MilliQ water (a repeat of procedure 1.6.3) 

 2. cleaning with 0.1N NaOH.  

 3. flushing once more with MilliQ water (procedure 1.6.3). 

Cleaning may be initiated and left to continue while the subsequent 

operation (chromatography) is performed. 

   

# Task 
Initials/ 

Date 

Verifier/ 

Date 

1 

To begin cleaning the Millipore TFF apparatus and Pellicon 

filter, repeat flushing of the unit with 500 ml water, as described 

in procedure 1.6.3. steps 1 through 14 

  

2 

Disconnect the retentate tubing (silicone, translucent) from RET 

IN port and place in waste collection vessel. Place the end of the 

permeate tubing in the waste collection vessel. 

  

3 Open the retentate valve by turning it counterclockwise.    

4 

Remove the reservoir cover and fill with 500 ml of 0.1N NaOH. 

Ensure the vent port is open by removing the plug from the 

VENT port and either leave open or install a Millex Filter.  

  

5 Open the tank outlet valve.   

6 

Turn the pump on and increase the pump speed until the feed 

pressure gauge reads 20 psi. Check all system connections for 

leaks and tighten any connections as necessary. 

  

7 

Continue pumping to the waste collection vessel until the level 

in the reservoir drops to 250 ml and then turn the pump off. 

Reconnect the retentate (silicone, translucent) tubing to the RET 

IN port.  

  

8 

Connect the male luer end of the permeate tubing to the 

recirculation (DIA / RECIRC) port. Turn the pump on and 

increase the pump speed until the feed pressure gauge reads 20 
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psi. Check all system connections for leaks and tighten any 

connections as necessary. 

9 

Adjust the retentate valve restriction by slowly turning the 

retentate valve clockwise until the retentate pressure gauge 

reads10 psi. Adjust the pump speed and retentate valve 

restriction to achieve 30 psi feed pressure and 10 psi retentate 

pressure. 

  

 

 

10 
Recirculate the cleaning solution for 30-60 minutes and then turn 

the pump off.  

  

11 

To drain the system, disconnect the pump outlet (Sta-pure, 

white) tubing from the pump outlet port and place in waste 

collection vessel. Open the retentate valve by turning it anti-

clockwise 

  

12 

Disconnect the retentate silicone (translucent) tubing from the 

RET IN port. Fluid should now drain by gravity. If additional 

drainage is required, a syringe can be placed on the end of the 

retentate tube and fluid can be blown down.  

  

13 
Replace retentate tubing (silicone, translucent) in retentate port. 

Reconnect pump outlet tubing (Sta-Pure, white). 

  

14 
Disconnect FEED IN tubing and place in collection vessel. Open 

tank outlet valve, turn pump speed up and let the reservoir drain. 

  

15 
Stop the pump, close the outlet valve and  Reconnect the pump 

outlet tubing (Sta-Pure, white) to the Feed In port. 

  

17 
Repeat Flushing with MilliQ water as described above in 

Procedure 1.6.3. steps 1 through 14 

  

     

     

 1.6.9  Pellicon XL Cassette Storage     

# Task   

1 
Turn/loosen all of the lock nuts until you are able to remove the 

Pellicon XL cassette.  

  

2 Fill a 10 ml syringe with 0.05N NaOH Storage solution.   

3 

Place the cassette in sink or tray that can contain any overflow. 

Attach the syringe to the retentate port and slowly push the 

solution into the device. Remove the syringe and replace all of 

the plugs on the ports and store flat at 4°C-25°C. 

  

     

     

 1.6.10 Clean Base    

# Task   
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1 Disconnect the power cord.   

2 
Clean exterior surfaces, reservoir, and Labscale System Base 

with a mild soap and water solution.  

  

     

     

     

1.6.11. Attchments 

 

 
Figure 1: Reservoir Set Up 
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(http://www.millipore.com/userguides.nsf/docs/p60085) 

 
 

Figure 2: Pump Base Set Up 

(http://www.millipore.com/userguides.nsf/docs/p60085) 

 

 
 

Figure 3: Installation of Pellicon XL Device 

(http://www.millipore.com/userguides.nsf/docs/p60085) 

http://www.millipore.com/userguides.nsf/docs/p60085
http://www.millipore.com/userguides.nsf/docs/p60085
http://www.millipore.com/userguides.nsf/docs/p60085
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2.0 Chromatography Operation: 

 

2.1  Description 
2.1.1. This batch record covers the precise operating steps necessary to purify recombinant 

mAb from concentrated conditioned cell culture medium using protein A affinity 

chromatography with the AKTA pure instrument. 

      2.2 Reference 

Title 
Document 

Number 

SOP: Isolation of mAb (cNIST) from Conditioned Medium by Protein A 

Affinity Chromatography on the ÄKTApure Chromatography System 

DP012 

SOP: Operation of AKTA pure Chromatography System DP 5 

SOP: Operation of NanoDrop 2000 Spectrophotometer QCB 11 

 

  2.3.Equipment 

Equipment Type Manufacturer, Model 

Number 

Calibration 

Due Date 

Initials/Date Verifier/Date 

Chromatography 

System 

GE Healthcare 

AKTApure 25 

   

Column HiTrap Protein A-HP, 

1ml 

Note: remove the 

column from 4ºC 

storage and allow to 

come to room 

temperature 

N/A   

 

2.4.Materials 

Component Quantity 

Required 

Quantity Used Initials/Date Verifier/Date 

Fraction tubes 30    

Syringe, 10 ml 2    

0.2 µm syringe filter 1    

Ehrlenmeyer flask, 

125 ml 

1    

Ehrlenmeyer flask, 

500 ml 

1    

50 ml conical tube 1    

0.2 µm vacuum fliter 

unit  

4    
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  2.5. Solutions 

Solution ID 
Date 

Prepared 

Volume 

Required 

Volume 

Used 

Initials/ 

Date 

Buffer A 20 mM sodium phosphate buffer, pH 

7.0 

 500 ml   

Buffer B 0.1 M sodium citrate, pH 3.0  200 ml   

MiliQ 

water 

Filtered, degassed MilliQ water  500 ml   

System 

Storage 

Solution 

20% Ethanol  300 ml   

Neutralizer 1 M Tris base pH 9.0  100 ml   

 

2.6.Procedure 

 

 2.6.1. Preparation of Buffers and Solutions      

# Task Initials/Date Verifier/Date 

 Buffer A: Binding buffer:  20 mM sodium phosphate, pH 7.0  

1 
Weigh 1.084 ± 0.02g NaH2PO4 and transfer to a 1200ml 

beaker with magnetic stir bar. 
  

2 
Weigh 3.2 ± 0.02g Na2HPO4.7H2O and transfer to the 

same beaker. 
  

3 
Measure 980ml MilliQ water in a graduated cylinder and 

add the water to the solids in the beaker.   
  

4 
Stir until the solids have dissolved, check the pH, if 

needed adjust the pH with 1N phosphoric acid.  
  

5 
Transfer to a 1L graduated cylinder and adjust the final 

volume to 1L. 
  

6 
Sterile filter the solution, allowing it to degas for 15-20 

minutes. Label appropriately. 
  

    

 Buffer B: Elution buffer:  0.1M sodium citrate, pH 3.0  

1 
Weigh 3.84g citric acid in a 400 ml beaker with magnetic 

stir bar. 
  

2 Dissolve in 180 ml MilliQ water.   

3 
Adjust the pH dropwise with 10N NaOH, to a final pH of 

3.0 
  

4 
Transfer the solution to a 250 ml graduated cylinder. 

Adjust the final volume to 200 ml 
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5 
Sterile filter the solution, allowing it to degas for 15 – 20 

minutes.   Label appropriately 
  

    

 1M Tris base pH 9.0: neutralizer.   

1 

Weigh 12.11g Tris base 

[tris(hydroxymethyl)aminomethane] into a plastic weigh 

boat and transfer to a 200 ml beaker with a stir bar. 

  

2 

Measure 90 ml MilliQ water in a graduated cylinder and 

transfer the water to the beaker containing Tris powder. 

Stir until dissolved. Adjust the pH to 9.0 with 10M HCL 

  

3 

Transfer the Tris solution quantitatively to a 100 ml 

graduated cylinder, rinsing the beaker with small aliquots 

of water, which are then added to the cylinder until a final 

volume of 100 ml is obtained. 

  

4 
Sterile filter the solution with a 0.22 µm filter. Degassing 

is not necessary. 
  

 

2.6.2. Start-up and preparation of AKTA Chromatography Instrument and Computer 

# Task Initials/Date 
Verified 

Initial/Date 

1 Place or verify that Buffer A is in place, securely 

located atop the instrument.  

Insert tubing for inlet A1 to the bottom of the 

container. 

 

Approximate volume of Buffer A:_________ ml 

 

  

2 Place or verify that the Buffer B container is in 

place, securely located atop the instrument. Insert 

tubing for inlet B1 to the bottom of the container. 

 

Approximate volume of Buffer B:_________ ml 

 

  

3 The On/Off switch for the instrument is located on 

the right side toward the rear of the housing. Switch 

to the ‘On’ position 

  

4 The computer On/Off switch is located on the front 

of the Dell desktop computer unit, near the top of 

the case.  Press in to turn on the computer 

  

5 Login to the computer using credentials provided by 

the College 
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6 Double click the Unicorn 6.3 icon on the desktop to 

open the software which controls the instrument 

functions.  Click OK in the “Log In – Unicorn” 

dialog box that appears. 

  

7 Open the System Control window (under Tools 

menu, if not opened automatically on startup) 

  

8 The top pane of the window will show the current 

state of the instrument, and the bottom pane shows 

the fluid path and manual controls. If the window is 

blank, go to the System menu and select Connect to 

Systems, check the box by AKTA pure 25 and click 

OK 

  

 
 

2.6.3. Priming the pump rinsing system 
  

# Task Initials/Date 
Verified 

Initial/Date 

1 
Remove the pump rinsing liquid tube from the holder 

located on the right-hand bottom corner of the system 
  

2 
Fill the pump rinsing liquid tube with 50ml of 20% 

ethanol 
  

3 Place the pump rinsing liquid tube back in the holder   

4 
Insert the inlet tubing to the system pump piston rinsing 

system in the rinsing solution tube. 
  

5 

Connect a 25 to 30 ml syringe to the outlet tubing of the 

system pump piston rinsing system. Draw liquid slowly 

into the syringe 

  

6 Disconnect the syringe and discard its contents.   

7 
Fill the rinsing solution tube so that the tube contains 50 

ml 0f 20% ethanol. 
  

 
     2.6.4 Prime inlets and purge pump heads 

# Task Initials/Date 
Verified 

Initial/Date 

1 Make sure that all inlet tubing that is to be used during the 

method run is placed in the correct buffer 

  

2 Turn on the AKTA pure system if not already on   

3 Open the unicorn 6.3 software   

4 Open the system control module in the unicorn 6.3 

software 

  

5 In the Process Picture click on the buffer inlets and select 

B2 
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6 Connect 20 ml syringe to right pump head of pump 

system B Make sure that the syringe fits tightly 

  

7 Open the purge valve by turning it counterclockwise 

about three quarters of a turn. Draw liquid slowly into the 

syringe until liquid reaches the pump and no air bubbles 

are visible in the line. 

  

8 Close the purge valve by turning it clockwise. Disconnect 

the syringe and discard its contents 

  

9 In the Process Picture click on the buffer inlets and select 

B1 

  

10 Connect 20 ml syringe to left pump head of pump system 

B Make sure that the syringe fits tightly 

  

11 Open the purge valve by turning it counterclockwise 

about three quarters of a turn. Draw liquid slowly into the 

syringe until liquid reaches the pump and no air bubbles 

are visible in the line 

  

12 Close the purge valve by turning it clockwise. Disconnect 

the syringe and discard its contents 

  

13 In the Process Picture click on the buffer inlets and select 

A2 

  

14 Connect 20 ml syringe to right pump head of pump 

system A Make sure that the syringe fits tightly 

  

15 Open the purge valve by turning it counterclockwise 

about three quarters of a turn. Draw liquid slowly into the 

syringe until liquid reaches the pump and no air bubbles 

are visible in the line 

  

16 Close the purge valve by turning it clockwise. Disconnect 

the syringe and discard its contents 

  

17 In the Process Picture click on the buffer inlets and select 

A1 

  

18 Connect 20 ml syringe to left pump head of pump system 

A Make sure that the syringe fits tightly 

  

19 Connect 20 ml syringe to right pump head of pump 

system A Make sure that the syringe fits tightly 

  

20 Open the purge valve by turning it counterclockwise 

about three quarters of a turn. Draw liquid slowly into the 

syringe until liquid reaches the pump and no air bubbles 

are visible in the line 

  

21 Close the purge valve by turning it clockwise. Disconnect 

the syringe and discard its contents 

  

22 Verify that the piece of waste tubing connected to the 

injection valve port W1 is placed in a waste vessel 
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23 In the Process Picture click on the injection valve and 

select System pump waste. The injection valve switches 

to waste position. This is necessary to achieve a low back 

pressure during purge procedure 

  

24 In the Process Picture click on the pumps   

25 Set Conc % B to 100% B and click Set % B. only system 

pump B is active 

  

26 In the Process Picture click on the buffer inlets and select 

B1. The inlet valve switches to the selected port.  

  

27 In the Process Picture click on the pumps   

28 Set the System flow to 1.0 ml/min. Click Set flow rate.   

29  Connect a 10 ml syringe to the purge valve of the left 

pump head of system pump B. Make sure that the syringe 

fits tightly into the purge connector 

  

30 Open the purge valve by turning it counterclockwise 

about three quarters of a turn. Draw a 5ml of liquid slowly 

into syringe. 

  

31 Close the purge valve by turning it clockwise. Disconnect 

the syringe and discard its contents.  

  

32 Connect the syringe to the purge valve on the right pump 

head of System pump B, Make sure that the syringe fits 

tightly into the purge connector 

  

33 Open the purge valve by turning it counterclockwise 

about three quarters of a turn. Draw a 5ml of liquid slowly 

into syringe 

  

34 Close the purge valve by turning it clockwise. Disconnect 

the syringe and discard its contents. Keep the system flow 

running 

  

35 To validate purge of pump B,In the Process Picture click 

on the Injection valve and select Manual Load. 

  

36 In the Chromatogram pane check the PreC pressure. If 

the PreC pressure does not stabilize within a few minutes, 

there may be air left in the pump. Refer AKTA pure 

system handbook for a troubleshooting guide.  

  

37  In the Process Picture click on the injection valve and 

select System pump waste. The injection valve switches 

to waste position. 

  

38  In the Process Picture click on the pumps    

39 Set Conc % B to 0% B and click Set % B. only system 

pump A is active  

  

40 In the Process Picture click on the buffer inlets and select 

A1 
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41 Set the System flow to 1.0 ml/min. Click Set flow rate. A 

system flow starts 

  

42 Connect a 20 ml syringe to the purge valve of the left 

pump head of system pump A. Make sure that the syringe 

fits tightly into the purge connector. 

  

43  Open the purge valve by turning it counterclockwise 

about three quarters of a turn. Draw a 5ml of liquid slowly 

into syringe.  

  

44 Close the purge valve by turning it clockwise. Disconnect 

the syringe and discard its contents.  

  

45 Connect the syringe to the purge valve on the right pump 

head of System pump A. Make sure that the syringe fits 

tightly into the purge connector 

  

46 Open the purge valve by turning it counterclockwise 

about three quarters of a turn. Draw a 5ml of liquid slowly 

into syringe 

  

47 Close the purge valve by turning it clockwise. Disconnect 

the syringe and discard its contents.  

  

48 To validate purge of pump A, In the Process Picture 

click on the Injection valve and select Manual Load 

  

49 In the Chromatogram pane check the PreC pressure. If 

the PreC pressure does not stabilize within a few minutes, 

there may be air left in the pump. Refer AKTA pure 

system handbook for a troubleshooting guide.   

  

50  Confirm that the HiTrap protein A HP 1ml column is 

installed on a chromatography system. If not refer to 

“SOP: Isolation of mAb (anti IL-8) from Conditioned 

Media by Protein A Affinity Chromatography on the 

ÄKTApure System” Document # DP12 

  

 

2.6.5. Preparation and Installation of 10 ml SuperLoop 

# Task Initials/Date 
Verified 

Initial/Date 

1 Rinse and dry the entire disassembled Superloop parts if 

not done already.  

  

2 Insert the 18 cm tube into a female threaded connector 

(black).  

  

3 Connect the male threaded connector to the female 

threaded connector inserted into an 18 cm tubing. Make 

sure the tube is snug tight 

  

4 Connect the male threaded connector to one of the inner 

end pieces.  
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5 Insert the 28 cm tube into a female threaded connector 

(black) 

  

6 Connect the male threaded connector to the female 

threaded connector inserted into a 28 cm tubing. Make 

sure the tube is snug tight  

  

7 Rinse/wet O-rings on the end pieces and movable seal 

with deionized water. 

  

8 Insert the movable seal into the graduated glass tube from 

the bottom (zero) end in such a way that the end with O-

ring is closest to the bottom. Using a glass rod with 

smooth end or a plastic pipette, push the seal into the tube 

until the O-ring is between the 1ml and 2 ml graduations.  

  

9 Mount the glass tube on a lab stand with clamp. Working 

over a sink or container to catch any overfill, pipet enough 

buffer A into the upper portion of the tube to fill it.  

  

10 Mind the liquid that will squirt from the tubing; direct it 

into the sink. Insert the inner end pieces with the 18 cm 

tubing attached into the glass tube, contacting the liquid 

meniscus to eliminate air bubble entrapment. Press the 

end piece completely into the glass tube 

  

11 Invert the tube in the clamp/support and wet the movable 

seal with a small amount of 20% EtOH (or buffer A if it 

contains a detergent). It may be necessary to use the pipet 

to eject any air bubbles that stubbornly adhere to the glass 

and/or movable seal. When bubbles have been eliminated, 

completely fill the tube with buffer A. Minding the liquid 

that will squirt from the tubing, insert the remaining inner 

end piece with tubing attached.   

  

12 Rotate the bottom inner end piece with 28 cm tubing so 

that the slotted end (inside the glass tube) aligns with the 

small notch inside the glass tube. This alignment is 

important to establish and maintain; otherwise, 

backpressure in the pumps could increase and prevent 

completion of the run.  

  

13 Remove the glass tube with end pieces from the clamp.    

14 Attach the bottom outer end piece by threading it onto the 

glass tube.  

  

15 Slide the plastic protective jacket over the glass tube and 

seat it firmly into the bottom outer end piece.  

  

16 Attach the top outer end piece to the remaining exposed 

threaded end of the glass tube 
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17 To install the assembled Superloop 10 onto the AKTA 

pure instrument, place the lab support and clamp near the 

instrument on the left side, then mount the Superloop in 

the clamp. Adjust clamp vertically and horizontally as 

needed to place the Superloop in close proximity to the 

injection valve 

  

18 Attach the tubing on the top of the Superloop to the 

injection valve port labeled ‘loop E’ using the threaded 

connector. Confirm that the tubing is firmly attached and 

will not easily pull out of the fitting.   

  

19 By default, the injection valve should be in the ‘Manual 

Load’ position upon booting up the instrument. Using the 

manual control feature in the Unicorn software, confirm 

that the valve is in Manual Load position. If not, switch 

the valve to the correct position by clicking the injection 

valve on the system control diagram, then selecting 

‘Manual Load’. 

  

20 Attach the bottom Superloop tubing to the injection valve 

port labeled ‘loop F’ using the threaded 

connector.  Confirm that the tubing is firmly attached and 

will not easily pull out of the fitting.  

  

21 Confirm the inlet tubing A1 is in the Buffer A container   

22 Using the manual control panel in the System Control 

window, click on Pump A in the diagram and select 

“Pump A Wash” 

  

23 Upon completion of the wash, set the flow rate to 1 

ml/min. Click on the injection valve depiction and select 

“Inject”. 

  

24 When the Superloop movable seal arrives at the zero 

position, change the injection valve position to ‘Manual 

Load’. Allow the pump to continue at 1 ml/min.  

  

25 Fill a 10 ml syringe with buffer A and inject sufficient 

volume to completely fill the Superloop.  

  

26  Once again, change the injection valve position to 

‘Inject’ using the manual control feature of the software 

interface. Increase the flow rate to 2 ml/min.  

  

27 When the Superloop movable seal is at the zero position, 

stop the pump. Click the ‘Stop’ icon (a solid square) in 

the toolbar near the top of the System Control window.  

  

 

2.6.6. pH Electrode Calibration   
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Task Initials/Date 
Verified 

Initial/Date 

Obtain three small beakers and pH standards for pH 4.01 and 

pH 7.0, as well as a 10 ml syringe and a bottle of MilliQ 

water. 

  

In the Unicorn System Control window, choose ‘Calibration’ 

from the System menu. From the drop down menu under 

‘Monitor to calibrate’, select ‘pH’. 

  

Click the ‘Prepare for Calibration’ button. You will hear the 

valve switch to the calibrate position. 
  

Follow the on-screen instructions for both pH standards. 

Enter the pH of the first pH standard buffer in the pH for 

buffer 1 field 

  

Fill a syringe with approximately 10 ml of the first pH 

standard buffer (pH 7). Connect the syringe to the Luer 

connector of pH valve port Cal, and inject the buffer.  When 

the Current value is stable, click the Calibrate button. 

  

Thoroughly rinse the syringe with 3-4 changes of MilliQ 

water. Wash the pH flow cell by injecting water into pH 

valve port Cal. 

  

Enter the pH of the second pH standard buffer in the pH for 

buffer 2 field. Fill a syringe with approximately 10 ml of the 

second pH standard buffer. Connect the syringe to the Luer 

connector of pH valve port Cal, and inject the buffer.  When 

the Current value is stable, click the Calibrate button. 

  

The calibration date and time are displayed in the dialog, 

along with values for Calibrated electrode slope (should 

be ≥ 80%) and Asymmetry potential at pH 7 (should be 

within the interval ± 60 mV.  If the conditions are met, click 

the Close button to switch the pH valve back to the default 

position and to close the Calibration dialog. 

  

 

2.6.7. Preparation of fraction collector 

# Task Initials/Date 
Verified 

Initial/Date 

1 Prepare 30 fraction collector tube by adding 200µl 1M 

Tris pH 9.00 to the bottom of each tube 

  

2 Load prepared 30 collection tubes into the fraction 

collector starting at position 1.  

  

3 Place the fraction collector tube 1 near the outlet tubing 

from the instrument (refer to attachment Fig 1) so that it 

will touch the arrow on the white paddle of the fraction 
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collector arm. Note: To rotate the carousel, reach around 

the left side of the collector to find a rubber roller pressing 

against the carousel (Fig 2). Pull the roller away from the 

carousel (Fig. 3); the carousel will rotate freely as long as 

the roller is held. When the first tube is in the correct 

position, release the roller. 

4 Gently raise the arm and swing it into position against 

tube 1 

  

 

 

     2.6.7. Column Equilibration 

# Task Initials/Date 
Verified 

Initial/Date 

1 Equilibrate system and column as follows: 

1)Navigate to the System Control window. 

2) If the window is blank, choose menu item 

System\Connect to System and choose OK 

2) In the File menu, select Open\Hi Trap Protein A 1ml 

Equilibration 

3) Click Next until the Start button is shown, then choose 

start 

4) Allow the method to run to completion (about 15 

minutes). 

 

  

 

2.6.8. Protein A Affinity Chromatography 

 

            Chromatographic run sequence summary: 

 1) Inject 5.0 ml from the Superloop; begin collecting 5 ml fractions; flow rate = 0.5 

ml/min. 

2) Wash unbound proteins through with up to 15 column volumes (CV) buffer A, until 

A280 stabilizes; collecting 2.5 ml fractions. Flow rate = 1 ml/min. 

3) Elute bound immunoglobulins with step to 0.1M Na-citrate, pH 3; collecting 1 ml 

fractions and peak fractionation, for a total of 15 CV 

 4) Re-equilibrate column in buffer A until pH stabilizes; maximum 20 CV. Eluent to 

waste. 

 

# Task Initials/Date 
Verified 

Initial/Date 

1 Obtain the concentrated cNIST mAb with your company 

name (prepared in step 1.6.7.) 
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Sterile filter the sample using 10 ml syringe and 0.22 µm 

syringe filter in a 50 ml conical tube. 

Record the sample information  

Sample origin: 

 

Batch #: _________________ 

Date prepared: _________________ 

 

Volume:_________________ 

 

2  Sample injection into 10 ml Superloop: 

1) Fill 10 ml syringe with 5.5ml of filtered sample, being 

careful to avoid or eliminate any air bubbles 

2) Dispense excess sample back into its original container, 

retaining 5.5 ml in the syringe 

3) Insert syringe firmly into sample inlet port with Luer 

lock tightened 

4) Inject 5.5 ml Superloop  

 

  

3 Initiate the run: 

1)Using the Unicorn 6.3 software, open the System 

Control window. 

2)Under the File menu, choose Open\1ml Protein A 

Column ver2_5ml 

3) In the resulting dialog box, input Sample Info into the 

designated cell. 

4) Enter 

5) Click Next (repeatedly) until the Start button is shown 

in the dialog box.  

6) Click Start to begin the separation process. 

  

4 Upon completion, transfer the labeled tubes to a tube rack 

and store at 4ºC for later analysis. 

  

5 Repeat the step 6.1 and 6.5 with remaining sample    

 

 2.6.9. Evaluate Chromatographic Separation 

# Task Initials/Date 

Verified 

Initial/

Date 

1 Open the chromatogram (will be the most recent one listed) in 

Unicorn “Evaluation” tool as follows: 

1) In Unicorn 6.3 software, under the Tools menu, choose 

Evaluation. 
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2.6.10. Equipment shut-down and short term (less than 3 days) storage  

# Task Initials/Date 
Verified 

Initial/Date 

1 After completion of the final separation of the day, 

transfer Inlet tubing A1 and B1 to a flask of degassed 

Milli-Q water (250 ml or greater).   

  

2 In the Unicorn software, open the System Control 

window.  

  

3 Under the File menu, choose Open, then select the method 

‘System Short Term Storage’ 

  

4 Click Start   

5 Allow the method to run to completion, as indicated by an 

audible tone and onscreen window.  

  

2) In the Evaluation window, click the Results tab.  

3) Find yours in the listed chromatograms, then double click to 

display it in the right frame.   

2 Optional: 

Customize chromatogram: 

1)Open Customize tool  

2)Accept the default, or select curves for UV, conductivity, 

fractions;  

3)adjust Y axis values for optimum display of curves 

 

  

3 Optional. Determine protein content per fraction by Bradford 

Protein Estimation. Refer to the SOP for that procedure.  

  

4 Optional Use Operations\Fraction Histogram to indicate 

average protein content per fraction. 

  

5 Optional. Use Operations\Activity Histogram to enter g 

amount per fraction, as determined using the ELISA or other 

analytical technique to determine specific Ab content. 

  

6 Save and Print: 

Save the chromatogram as a pdf: 

1) While displaying finished chromatogram, choose File\Print 

2) In the resulting dialog box, choose Preview  

3) In the window that opens, click File\Save as PDF 

4) Enter a name which refers to the sample, column and date 

(e.g. antiIL8 on HiTrap Protein A HP 09APR15) 

5) Print a copy of the chromatogram for record keeping 

  

7 Save changes.   
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6 Place the pH valve in the ‘Calibration’ position (System 

Control window; System\Calibrate menu). Fill a 10 ml 

syringe with pH electrode storage solution and inject 9 ml 

into the calibration port. Leave the syringe attached.  

  

7 Turn off the instrument or perform the long-term storage 

routine as needed 

  

 

 

2.6.11. Cleaning of the Superloop 10 sample holder- short term.   

# Task Initials/Date 
Verified 

Initial/Date 

1 For short term storage of the Superloop on the AKTA 

instrument, inject 2 ml Milli-Q water into the sample 

chamber 

  

2 Pump it out to waste by temporarily disconnecting the 

outlet tubing that is connected to the injection valve at 

port ‘loop F’.    

  

3 Using manual control in the System Control window of 

Unicorn, set the flow rate to 2 ml/min and the injection 

valve position to Inject. Allow pump A to run until the 

Superloop chamber is empty 

  

4 Reconnect to ‘loop F’   

5 Repeat steps 1 through 4 on this section three times   

6 Inject 10 ml water into the sample chamber of the 

Superloop.   

  

 

2.6.12. Equipment shut-down and long term (3 days or more) storage  

# Task Initials/Date 
Verified 

Initial/Date 

1 After completion of the System Short Term Storage 

method, transfer Inlet tubing A1 and B1 to a flask of 

degassed 20% ethanol (250 ml or greater). 

  

2 In the Unicorn software, open the System Control 

window.  

  

3 Confirm that the pH valve is in the ‘Bypass’ or 

‘Restrictor’ position 

  

4 Under the File menu, choose Open, then select the method 

‘System Long Term Storage’.  

  

5 Click Start   

6 Allow the method to run to completion, as indicated by an 

audible tone and onscreen window.  
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7 Turn off the instrument.    

8 Remove the Superloop from the instrument and carefully 

disassemble it. Hand wash all parts with a general purpose 

lab cleaner, rinse well and allow to air dry. Store the dried 

components in their original box 
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